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Este documento possui as orientagoes e os
regramentos dos elementos que compdem
a marca Fundacao Vale.

Siga sempre as recomendagdes contidas nesse guia
para garantir a consisténcia e a integridade da nossa
marca. Em caso de duvidas, consulte o ponto focal
de comunicacao da Fundacao Vale.
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Ildentidade
Visual



Identidade Introducao

Visual Identidade Visual Institucional e Territorial
Introducao
Logo Nossa comunicacao é feita por meio de duas abordagens: Identidade Ja a Territorial abre espaco o uso das outras cores da paleta principal e
c o L Visual Institucional e Identidade Visual Territorial. uma cor da paleta secundaria. Incorpora elementos graficos dos
ores 4o Logo A Institucional fala sobre a Fundacao de maneira mais corporativa e territérios em que esta inserida com a finalidade de conversar
Tipografia utiliza as cores do logo. diretamente com o local.
Fotografia
Identidade Visual Institucional Identidade Visual Territorial
Institucional
Cores

Composicao

FUNDAGAO ke S L o FUNDACAO
VALE R T L VALE

One page
Boas praticas r S O\ =~
Sed vulputate .. TN N Sed vulputate
L diam auctor B - WS diam auctor
Territorial o »
Cras sed nisi sed & g NS Cras sed nisi sed
Cores oz cuisines / e NN Sy N\ S libero euismod
auctor. Integer _ N N U .
Composicdo sagittis orci ‘ auctor diam.
condimentum
One page tellus
condimentu, ut
Boas praticas venenatis nulla.

Nulla finibus
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Identidade Introducao

Visual Elementos Graficos
Introducao
Logo A ldentidade Visual Institucional e a Identidade Visual Territorial da aparecer nas cores Verde Vale, Amarelo Vale e Branco; e na Identidade
Fundacao Vale compartilham o mesmo logo, estilo fotografico e tipografia.  Territorial os grafismos abrangem mais cores e podem ser personalizados
Cores do Logo Ambas também possuem os mesmos grafismos, mas estes se comportam quando estiverem falando sobre algum tema especifico dentro de um
Tipografia de maneiras diferentes: na Identidade Institucional os grafismos sé poderao  territério. Vocé tera mais informacgdes no decorrer deste manual.
Fotografia
Elementos graficos comuns
Logo Cores do Logo Estilo Fotografico Tipografia
Institucional | -
Core FUNDACAO Vale Sans Lig t
Composicio VALE Vale Sans Medium
One page Vale Sans Bold

Boas praticas

Elementos graficos particulares

Territorial
Institucional Territorial
Cores Paleta e proporcao cromatica da identidade institucional Paleta e proporcao cromatica da identidade territorial
Composicao
One page
Boas praticas
Grafismos: Grafismos:
-3
*x
3x
3t
%
*
3x
X
P 4
3t
3t
3t
3
Contornos Caixas llustracoes Contornos Caixas llustracoes
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Identidade Logo
Visual Conceito criativo

Introducao
O simbolo da Fundacao Vale nasce de conceitos que representam a ideia

de contribuicao com o desenvolvimento dos territérios onde operamos.
Ao abracar esses conceitos, a Fundacao Vale amplia e potencializa

Logo

Cores do Logo

Tipografia milhares de vozes. E esse movimento passa a fazer parte da nossa
Fotografia identidade visual.
Aspa:
Institucional Dialogo com
a sociedade
Cores

Composicao
One page

Boas praticas

Territorial
Cores Abraco:
Composic¢ao Envolvimento
One page

Boas praticas

Encontro:
Fazer junto
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Identidade Logo

Visual Versio Preferencial
Introducao
Logo A versao positiva colorida é a que melhor destaca o nosso logo, seus detalhes
; e suas cores. Ela oferece melhor leitura e um reconhecimento mais facil e rapido.
Cores do Logo Por isso, esta é a versao preferencial e tem seu uso priorizado.
Tipografia
Fotografia
Institucional
Cores

Composicao
One page

Boas praticas

FUNDACAO
VALE

Territorial

Cores

Composicao

One page

Boas praticas

Versao preferencial: essa aplicagio deve ser sempre priorizada.
O ndo uso dessa versao é valido somente em casos de impedimentos técnicos.
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Identidade Logo
Visual English version

Introducao
Logo

Cores do Logo
Tipografia
Fotografia

Institucional

Cores
Composicao
One page

Boas praticas

VALE
FOUNDATION

Territorial

Cores

Composicao

One page

Boas praticas

Uso interno - Desenvolvido pela Geréncia de Marca & Publicidade



Identidade Logo
Visual Versoes Restritas

A versao monocromatica deve ser usada quanto houver a limitacao de apenas

Logo : : :
uma cor de uso, ou quando o logo precisar ser aplicado sobre fundos coloridos.

Cores do Logo

Tipografia
Fotografia Deve ser utilizada apenas quando
- - houver um fundo de cor ou
Institucional F U N DAg AO F U N DAGAO imagem que n3o afete a
visibilidade da marca.

VALE VALE

Composicao

One page
Boas praticas Monocromatica Negativa Monocromatica Positiva
Territorial |
Deve ser aplicada quando houver
Cores a necessidade de uma cor sélida

F U N DAGAO F U N DAGAO para atender as necessidades de

producado, como fax, alto relevo,

VALE VALE hot stamping, corte especial, etc.

Composicao

One page

Boas praticas

Monocromatica Negativa Monocromatica Positiva

Uso restrito: Utilize somente quando nao for
possivel a aplicagdo em mais de uma cor.
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Identidade Logo
Visual Versao em tons de cinza

Introducao
Use apenas em impressdes em escala de cinza. Para fundos de cores escuras,

use a versao negativa e, para fundos de cores claras use a versao positiva.
Sempre preste atencao no contraste entre o logotipo e o plano de fundo.

Logo

Cores do Logo
Tipografia
Fotografia

institucional ’ FUNDAGAO FUNDAGAO
VALE VALE

Cores

Composicao

Onepage I il 5

Boas praticas

: . Pantone Cool Gray 4C Pantone Dark Grey
Territorial COMOYOK30 COMOYOK75
Cores R171G171B 171 R48 G 48 B 48
HEX #ABABAB HEX #303030

Composicao
One page

Boas praticas

Uso restrito: Utilize somente quando nao for
possivel a aplicacdo em mais de uma cor.
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Identidade Logo
Visual Reserva e reducao

Introducao
Logo

Cores do Logo que compdem a Nossa marca.
Tipografia

Fotografia ,
Area de reserva

Institucional

A area de reserva e a redugdao maxima garantem a
leitura, o reconhecimento e a preservacao dos elementos

Cores

Composicao
One page

Boas praticas

Territorial

Cores

FUNDACAO

Composicao

One page

Boas praticas

A area de reserva é definida a partir da altura x de nosso logotipo.
Nao desrespeite essa drea em hipdtese nenhuma.
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Reducdo maxima
8 mm
Impressao

20 px
Digital

FUNDAGCAO
VALE



Identidade Logo
Visual Convivéncia

Introducao
Quando o logo é aplicado com outra marca, sempre respeite a distancia

Logo
minima usando como referéncia a largura do nome “VALE”.

Cores do Logo
Tipografia
Fotografia

Institucional

@ : swsoro | LOGOTIPO

Cores

Composicao

One page

Boas praticas

Territorial
Exemplo

Cores
Composicao

One page

Q FUNDACAO @ Lorem
Boas praticas VALE ipsum

Lembre-se de aplicar ajuste ético a regua de logos. Em alguns casos, a altura do logo da
outra marca pode ser maior ou menor que o logo da Fundacao Vale. Isto acontece para
que haja uma compensagdao e ambos possam ter a mesma forga em suas presencas.
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Identidade Logo
Visual Convivéncia

Introducao
Quando o logo é aplicado com outra marca, sempre respeite a distancia

Logo
minima usando como referéncia a largura do nome “VALE”.

Cores do Logo

Institucional F U N DAg AO
Cores VALE

Exemplo vertical

© e
BOLO HOICIONRIO, Q) Lorer

Composi¢ggpo &

One page

Boas praticas

Territorial

Cores
Composicao
One page

Boas praticas

Lembre-se de aplicar ajuste ético a regua de logos. Em alguns casos, a altura do logo da
outra marca pode ser maior ou menor que o logo do Instituto Cultural Vale. Isto acontece
para que haja uma compensacdo e ambos possam ter a mesma forca em suas presencas.
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Identidade Logo

Visual O que nao fazer
Introducao
Logo Veja a seguir, alguns exemplos do que nao fazer com o nosso logo. Use apenas as arte-finais oficiais
; Estas regras garantem a consisténcia e legibilidade e devem ser que foram disponibilizadas.
Cores do Logo respeitadas em todas as versdes do logo da Fundacao Vale. Nao recrie o logo.
Tipografia
Fotografia
Institucional ~ | - ~ <
FUNDACAO FUNDACAOQ FUNDACAO FUNDAGAO
cores VALE VALE VALE VALE

Composicao

One page @ N&o use outras cores além das @ N&o distorca @ N&o reproduza o logo @ Nao aplique contorno

Boas praticas mostradas neste manual com outra tipografia

r_4 Aguo molut abore, core, ulla nes atium aut repraest
ab ntur as vel in conseque
'Y ° AO P molut ] epudam dolupti onecto P
I ooooo e dole i\ntiorr ovid iS @ VO
err Itor Ia I lupt us cillug S Ofiscquassi aflaspefaui
~y ate ut ullau dolorem f OW 2y
qu os quis sandanit SRCIBIGIRN ilitatus et
na jna dolorescia gORRRlISIANt [a ut ommol uptam
rer ca ep udifERGEEREEREoNsequ N Cmn
Cores VA VA L E as Slempelinisacit qui VAL E

R VALE
OomposI¢ao

One page @ N3o altere a estrutura, ou @ N3o rotacione @ N&o aplique sombras @ N&o invada a area de protecao

L. posicao dos elementos
Boas praticas

FUNDACAO
VALE

Nao aplique o logo sobre Nao aplique a versao preferencial @ Nao aplique sobre fundo que @ Nao aplique sobre transparéncias
outras cores de fundo sobre fundo preto nao garanta o contraste de outras cores
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Identidade Logo
Visual Aplicacoes sobre fundos

Introducao
Veja a seguir, alguns exemplos de aplicagdes possiveis com o nosso logo.

Estas regras garantem a consisténcia e legibilidade e devem ser
respeitadas em todas as versdes do logo da Fundacao Vale.

Logo

Cores do Logo

Tipografia Aplicacoes da versao preferencial
Fotografia
ity FUNDACAO FUNDACAO FUNDACAO
nstitucional VALE VALE VALE
Cores
Composicao Branco Imagens com cores claras Materiais claros
One page
Boas praticas Aplicagoes da versao monocromatica negativa
Territorial FUNDACAO FUNDACAO FUNDACAO
Cores VALE VALE VALE

Composicao
Cores escuras contrastantes com branco Imagens que contrastem com branco Materiais escuros
One page
Boas praticas
Aplicagoes da versao monocromatica positiva

FUNDACAO 7

VALE S,

) VALE

Cores claras contrastantes com preto Imagens que contrastem com preto Materiais coloridos
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Identidade
Visual

Introducao
Logo

Cores do Logo
Tipografia
Fotografia

Institucional

Cores
Composicao
One page

Boas praticas

Territorial

Cores
Composicao
One page

Boas praticas

Logo
O que nao fazer

Veja a seguir, alguns exemplos do que nao fazer com o nosso logo. Estas
regras garantem a consisténcia e legibilidade e devem ser respeitadas em
todas as versodes do logo da Fundacgao Vale.

Aplicacoes da versao preferencial

& 1‘!:%\\ ]:a,ﬂi HT £

N&ao utilize sobre imagens com grande Nao utilize sobre as mesmas Nao utilize sobre cores que
quantidade de informagao cores da marca dificultam a leitura da marca

Aplicacoes da versao monocromatica negativa

FUNDAgAO
‘ VALE --~- 

N&o utilize sobre imagens com grande @ N&o utilize sobre o mesmo @ N&o utilize sobre imagens
quantidade de informagao tom da marca nao constrastantes

Aplicagoes da versao monocromatica positiva

‘ i 5 ';ii—;‘ G-
B W
@ N3o utilize sobre imagens com @ N3o utilize sobre o mesmo @ N3o utilize sobre imagens
grande quantidade de informacgao tom da marca nao contrastantes
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Identidade Logo
Visual Posicao

Introducao

A posicao do nosso logo nas pecas de comunicagao também precisa de
atencao. Veja a seguir, alguns exemplos de como aplica-lo. Estas regras
garantem a consisténcia e legibilidade e devem ser respeitadas em todas

Logo

Cores do Logo

Tipografia as aplicacoes.
Fotografia
] 1 I 3%a6%  =H_ """ Exemplo
Institucional da menor A B g
medida do
COreS formato. c FUNDACAO

Composicao

One page

Sed vulputate
diam auctor

Boas praticas

Cras sed nisi sed libero
euismod auctor.
Integer sagittis orci
condimentum tellus
condimentum, ut
venenatis nulla finibus

Territorial
Nulla finibus
Cores
Composigao C D
| e e e e e e e e e e e - | _ _ _ _ _ _ _ _ _ __________

One page = u
Boas praticas X

Encontre o valor da margem Aplique o logo

As margens da moldura devem medir entre O logo podera aparecer em qualquer um

3% e 6% da menor medida do formato, no dos cantos do layout (A, B, C e D).

caso, representado pela letra “X".
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Identidade Logo
Visual Cores do logo

Introducao
Essas sao as cores do nosso logo. Estas cores devem ser utilizadas em

Logo : ~
todas as nossas aplicacdes.

Cores do Logo

Tipografia

Fotografia

. Verde-Vale Branco
Institucional

Cores
Composicao
One page
Pag Brilho Fosco
Boas praticas

Pantone 328 C Pantone 328 U

C100 M10 Y55 K10 C100 M20 Y60 KO C00 MOO YOO KOO
. . RO00 G126 B122 RO00 G126 B122 R255 G255 B255
Terrltorlal #007E7A #007E7A #FFFFFF
Cores
Composicao .
POSIS Amarelo-Vale Cinza-Vale
One page

Boas praticas

Brilho Fosco

Pantone 124 C Pantone 7406 U Pantone Cool Gray 9 C
CO0 M30 Y100 KO8 CO0 M20 Y100 KO5 C00 MO0O YOO K65

R237 G177 B17 R116 G118 B120
#747678

R237 G177 B17
#ECB11F #ECB11F

Uso interno - Desenvolvido pela Geréncia de Marca & Publicidade



Identidade Tipografia

Visual Vale Sans
Introducao :
Logo A tipografia é parte importante da nossa identidade visual, por isso, seu A Vale Sans esta disponivel na

pagina de marca da intranet
global. Caso ndo tenha acesso,
solicite a Equipe de Comunicacao.

uso correto e sistematico ajuda a criar uma imagem consistente e

Cores do Logo organizada. A Vale Sans pode ser distribuida sem qualquer tipo de

Tipografia limitacao, facilitando a utilizagdo e garantindo a consisténcia de materiais
Fotografia internos e externos. Também podera ser usada em websites e aplicativos.
Institucional

ABCDEFGHIJKLMNOPQRSTUVWXYZ

Composicao

One page

abcdefghijklmnopqgrstuvwxyz
1234567890#@!?/.+=$%&

Cores
Composicao

One page

A Vale Sans é versatil

Temos 6 pesos principais:

Light Medium Bold
Light italic Medium Italic Bold Italic
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Identidade
Visual

Introducao
Logo

Cores do Logo
Tipografia
Fotografia

Institucional

Cores
Composicao
One page

Boas praticas

Territorial

Cores
Composicao
One page

Boas praticas

Tipografia
Principais - como usar

Os recursos da tipografia e da diagramacao trazem personalidade a
nossa identidade visual e ajudam a tornar nossas mensagens mais
inspiradoras. O peso das fontes recomendadas pode ser ajustado
para dar énfase as informacdes importantes quando necessario.

Titulos e destaques:

Vale Sans Regular, Medium ou Bold.

Se o titulo estiver em um tamanho maior, que se destaque do texto corrido, podemos
optar pelo peso regular. Caso o titulo tenha tamanho igual ou parecido com o texto, o
medium e o bold sdo recomendados para manter a hierarquia de leitura.

Textos corridos:

Vale Sans Light ou Regular.

Legendas:

Vale Sans Light ou Regular.
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Devemos alinhar todos os textos a esquerda.
Textos legais, notas de rodapé e trechos
traduzidos podem estar em italico, se precisar.
Nao utilizar texto em CAIXA-ALTA!

FUNDACAO
VALE

Sed vulputate
diam auctor

Cras sed nisi sed
libero euismod
auctor. Integer
sagittis orci
condimentum
tellus
condimentu, ut
venenatis nulla.




Identidade Fotografia

Visual Exemplos
Introducao
Logo A fotografia da Fundacao Vale retrata um olhar préximo, positivo e atuacao juntamente com aqueles que recebem, colaboram e melhoram
verdadeiro do cotidiano das pessoas dos territérios onde atuamos. com a gente.
Cores do Logo | . . .
magens que reverberam o cuidado, didalogo e envolvimento na nossa
Tipografia
Fotografia
Institucional
Cores

Composicao
One page

Boas praticas

Territorial

Cores
Composicao
One page

Boas praticas
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Identidade Fotografia
Visual O que nao fazer

Introducao
Logo Veja, abaixo, algumas fotos que nao podem fazer parte da identidade:
Cores do Logo

Tipografia

Fotografia

Institucional

Cores
Composicao
One page

Boas praticas

Territorial

Nao use fotos com efeitos ou filtros

Cores
Composicao

One page °

Boas praticas

Nao use fotos muito escuras Nao use fotos posadas ou situagdes clichés Nao use fotos com ilustragdes ou interferéncias graficas
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ldentidade Visual
Institucional



Identidade Cores
Visual Cores da identidade

Introducao

Essas sao as nossas cores principais que devem
ser utilizadas em todas as nossas aplicacdes.
Para essa marca nao usaremos as cores em reticulas.

Logo
Cores do Logo

Tipografia

Fotografia

. Verde-Vale Branco
Institucional
Cores
Composicao
One page

Brilho Fosco
Boas praticas

Pantone 328 C Pantone 328 U

C100 M10 Y55 K10 C100 M20 Y60 KO C00 MOO YOO KOO
. . RO00 G126 B122 RO00 G126 B122 R255 G255 B255
Terrltorlal #007E7A #007E7A #FFFFFF
Cores
Composicao .
POSIS Amarelo-Vale Cinza-Vale
One page

Boas praticas

Brilho Fosco

Pantone 124 C Pantone 7406 U Pantone Cool Gray 9 C
CO0 M30 Y100 KO8 CO0 M20 Y100 KO5 C00 MO0O YOO K65
R237 G177 B17 R237 G177 B17 R116 G118 B120
#ECB11F #ECB11IF #747678
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Identidade Cores
Visual Barra de proporgcoes

Introducao

A barra de proporg¢des é um guia para que as cores sejam aplicadas da
forma correta. Ela nos ajuda a determinar o espaco que cada cor ocupa,
garantindo a consisténcia cromatica de nossa marca.

Logo
Cores do Logo

Tipografia

Fotografia

Institucional

Cores
Composicao
One page

Boas praticas

Territorial

Cores
Composicao
One page

Boas praticas

Principais Branco Cinza
Devem estar obrigatoriamente Areas em branco trazem a ideia de luz Os textos em cinza trazem
presentes nos materiais da Fundagao Vale. e garantem leveza as nossas pegas. a ideia de consisténcia.
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Identidade Composicao

Visual
Contorno
Introducao
Logo O contorno em varias camadas tem a intencao de indicar atitudes, ideias e acdes Vocé encontra os contornos em
c o L sendo multiplicadas e reverberadas. As forcas deste elemento sdao a sua massa de formato de “brush” nos arquivos
ores do Logo . . b . . . .
S cor bem presente, a flexibilidade da sua forma e a integracao fluida que ele fornecidos junto a este guia.
Tipografia apresenta com nossas fotos. A seguir, vocé confere como utilizar o contorno.
Fotografia )
Construcio Exemplos
Institucional | ,
iy o==mmm A forma-base do Contorno foi construida pela |
Cores intercalacao das cores Verde Vale, Amarelo Vale e _, ‘ Sed vulputate diam
o in ex congue auctor
Composicao Branco. -
Crgs sed nisi sed libero
One page > Cagitis rc condmernu
N - tellus condimet, ut venenatis
i | nulla finibus
Boas prétlcas o ': by - pellentesque.itant morbi.
), 'y A Nulla finibus
. . . No Adobe lllustrator, selecione a ferramenta Brush. Em seguida,
Territorial s |
abra a aba de tipos de brushes e escolha um dos contornos.
Cores

Composicao

One page

Boas praticas

NN ININ

Desenhe contornando a silhueta do assunto que queira dar destaque: uma pessoa,
um objeto, uma paisagem, etc. Ao contornar a forma, utilize poucos detalhes. A
ideia nao é ser fiel ao desenho, mas sim, referencia-lo de um jeito simples.
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Identidade Composicao

Visual Contorno
Introducao
Logo Os contornos devem transmitir a ideia de reverberacao do assunto da foto. Vocé encontra os contornos em
c o L Por isso, o correto controle da espessura e proporcao desse elemento é formato de “brush” nos arquivos
ores Ao Logo fundamental para que essa mensagem seja transmitida sem ruidos. fornecidos junto a este guia.
Tipografia
Fotografia )
Espessura e Proporcao
Institucional
Cores

Composicao
One page

Boas praticas

Territorial
Cores
Composicao ~ - . T 1 - .
Nao utilize contornos finos. A forca do Contornos com espessura média sao os ideais. Contornos grossos sao permitidos, mas deve-
One page contorno esta na sua massa de cor bem Esta espessura marca bem o layout, ao mesmo se ter atencao aos outros elementos do
Boas praticas presente. tempo que ndo disputa atencdao com imagens e layout. Quando houver a presenca desta
textos. espessura, € aconselhdvel que nao se utilize

texto. Caso seja necessaria a presenca de texto,

I . ele deve aparecer distante do contorno.
Resolvendo possiveis defeitos

Durante o desenvolvimento, caso apareca algum defeito ' ‘

nos contornos como no exemplo ao lado, basta diminuir Q
um pouco a espessura até que o defeito suma.

o\

Uso interno - Desenvolvido pela Geréncia de Marca & Publicidade



Identidade Composicao

Introducao

Logo

Uma maneira bem simples de contar nossa histéria é através das

caixas. Elas possuem funcao de abrigar textos e sao excelentes janelas

Cores do Logo

Fotografia

Construcao

Institucional

Cores

Composicao
One page

Boas praticas

v

Territorial

Cores
Composicao
One page

Boas praticas
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para as nossas fotos. A seguir, vocé confere detalhes de como as
Tipografia caixas foram construidas.

As formas-base das caixas
sao geométricas e simples

Foi aplicado o mesmo brush dos contornos nas linhas das

formas-base para atingir o resultado abaixo.

Vocé encontra caixas ja prontas pra
uso nos arquivos fornecidos junto a
este guia.

Exemplos

Lorem ipsum
dolor sit amet

Lorem ipsum dolor
sit amet,
consectetuer
adipiscing elit, sed
diam nonummy nibh
euismod tinci.

FUNDAGAO
VALE

Lorem Ipsum
Dolor Sit Amet

Lorem ipsum dolor sit
amet, consectetur
adipiscing elit, sed do

eiusmod tempor
incididunt ut labore et
dolore magna aliqua.



Identidade
Visual

Introducao
Logo

Cores do Logo
Tipografia
Fotografia

Institucional

Cores
Composicao
One page

Boas praticas

Territorial

Cores
Composicao
One page

Boas praticas

Composicao

®
Caixas
As caixas podem aparecer de maneira mais integrada as fotos Vocé encontra as caixas ja prontas
ao retirarmos as formas que as compdem. Abaixo vocé confere pra uso nos arquivos fornecidos
a melhor forma de usar este recurso. junto a este guia.

Usos e Proporcao

Lorem ipsum

dolor sit amet .
Lorem ipsum

dolor sit amet

Lorem ipsum
dolor sit amet

Lorem ipsum
dolor sit amet

Nao utilize contornos finos. Contornos com espessura média E possivel utilizar a parte mais A parte do meio do box também

A forca do contorno esta na sua sao os ideais. Esta espessura marca interna do box como janela pode ser vazada. Neste caso, opte

massa de cor bem presente. bem o layout, ao mesmo tempo para fotografias. Este tipo de por imagens mais limpas e que nao
que nao disputa atencdo com aplicacdo é ideal para destacar interfiram no entendimento do
Imagens e textos. situa¢des em uma imagem. formato da caixa.

Resolvendo possiveis defeitos

Durante o desenvolvimento, caso apareca algum defeito nos
contornos como no exemplo ao lado, basta diminuir um pouco
a espessura até que o defeito suma. Mantenha sempre a
aparéncia do baldao central préxima a sua forma-base
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Identidade Composicao

Visual llustragao
Introducao
Logo As ilustracdes enriqguecem nossa identidade visual e sao indicadas para Vocé encontra ilustracoes ja prontas
pecas mais livres, que tenham a intencao de agregar um valor mais pra uso nos arquivos fornecidos
Cores do Logo artistico. A seguir, vocé confere detalhes para a construcao de novas junto a este guia.
Tipografia ilustracoes.
Fotografia
Construcao Exemplos
Institucional : . |
As formas-base das ilustragées sdo sempre simples e
Cores ' - com baixa complexidade de detalhes. Para que possam
Composicao ter o efeito de reverberacao, precisam ter o efeito de

Offset Path aplicado.
One page

Boas praticas

Aplique efeito de offset pelo menos trés vezes no

Territorial objeto. Para fazer isso, no Adobe Illustrator, selecione o
objeto e siga 0 caminho no menu:
Cores Object -> Path -> Offset Path -> Offset = valor de 1/3 da

largura do objeto. Selecione a forma recém-criada e repita
0 passo mantendo o mesmo valor de offset.

QW=
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Composicao
One page

Boas praticas




Identidade One Page

Visual Resumo da identidade institucional
Introducao
Logo O painel abaixo mostra o resumo da identidade com os Todos as versdes dos logos da Fundagao Vale estao disponiveis no Pacote
principais elementos do universo visual da Fundacao Vale. de Identidade Visual que acompanha este guia. La vocé também
Cores do Logo encontra os grafismos em modo editavel e layouts editdveis para
Tipografia Respeite proporc¢ao de cores na régua deste resumo. consulta.
Fotografia
Institucional A vale Sans Light \V/a||e iaﬂs TRhm |
. ale Sans Regular
Cores I\:/XESAGAO Vale Sans Medium Vale Sans Semibold
Vale Sans Bold Vale Sans Extra Bold

Composicao

One page

Boas praticas

Territorial

Cores
Composicao
One page

Boas praticas

Sed vulputate
diam auctor
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Identidade

Visual

Introducao

Logo ") FUNDAGAO O Busca ok

Cores do Logo W VALE

Tipografia

Fotografia ) , . o .

(= Sobre a Fundagao Vale B8 Areas de atuacio {> Estacdes conhecimento % Editais [}] Publicagdes

Institucional

Cores

Composicao Sed vulputate diam

One page in ex congue auctor

Boas praticas

Cras sed nisi sed libero euis-
mod auctor. Integer sagittis
. . orci condimentum tellus
Terr|tor|a| condimentum, ut venenatis
nulla finibus pellen-
tesque.itante morbi.

Cores
Composicao
One page

Boas praticas
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Identidade
Visual

Introdugao
Logo

Cores do Logo
Tipografia
Fotografia

Institucional

Cores
Composicao
One page

Boas praticas

Territorial

Cores
Composig¢ao
One page

Boas praticas

Boas praticas

Lorem ipsum
dolor sit amet

Cras sed nisi sed libero euismod
auctor. Integer sagittis orci
condimentum tellus condimentum, ut
venenatis nulla finibus
pellentesque.itant morbi.

Tempor incididunt
ut labore lacus

Lorem ipsum dolor sitamet,
consectetur adipiscing elit, sed
do eiusmod tempor incididunt
ut labore et dolore magna

aliqua. Turpis cursus.

FUNDAGAO
VALE
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Identidade Boas praticas
Visual

Introducao
Logo

Cores do Logo
Tipografia
Fotografia

FUNDAGCAO
VALE

Institucional

Cores
Composicao
One page

Boas praticas

Territorial

Cores
Composicao
One page

Boas praticas
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Identidade Boas praticas
Visual

Introducao
Logo

Cores do Logo
Tipografia
Fotografia

Institucional

Cores )

Composicao _ | -

i FUNDAGAO
One page o VALE O
Boas praticas

FUNDACAO
VALE ;

Territorial

Cores
Composicao
One page

Boas praticas
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Identidade Boas praticas
Visual

Introducao
Logo

Cores do Logo
Tipografia
Fotografia

Institucional

Cores
Composicao
One page

Boas praticas

Territorial

Cores
Composicao
One page

Boas praticas

erno - Desenvolvido p




Identidade
Visual

Introducao
Logo

Cores do Logo
Tipografia
Fotografia

Institucional
Cores Lorem Ipsum

Composicdo Dolor Sit Amet
One page

Lorem ipsum dolor sit amet, consectetur
adipiscing elit, sed do eiusmod tempor incididunt

Boa S préticas ut labore et dolore magna aliqua. Ut enim ad

minim veniam, quis nostrud exercitation ullamco
laboris nisi ut aliquip ex ea commodo consequat.

Duis aute irure dolor in reprehenderit in
voluptate velit esse cillum dolore eu fugiat nulla

Te r r i t o r i a I | pariatur. Excepteur sint occaecat cupidatat non

proident, sunt in culpa qui officia deserunt mollit
anim id.

Cores
Composicao
One page

Boas praticas

FUNDACAO
VALE
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Identidade Visual
Territorial



Identidade Cores
Visual Paleta

Introducao
Essas sao as nossas cores principais que devem ser utilizadas em todas as nossas

Logo
aplicacbes. Para essa marca nao usaremos as cores em reticulas.

Cores do Logo

Tipografia o
Paleta Primaria
Fotografia
Verde_vale Brilho Fosco Branco
InStitUCionaI Pantone 328 C Pantone 328 U
;:)%% AQ:SGYSETO ;:)%% I\G/\f:;;;(o C00 MO0 YOO KOO
Cores #007E7A #007E7A R255 255 B255
#EFFFFF

Composicao

One page Amarelo-Vale RS fose Cinza-Vale
Boas praticas Pantone 124 C Pantone 7406 U
C00 M30 Y100 KO8 C00 M20 Y100 KOS5 Pantone Cool Gray 9 C
R237 G177 B17 R237 G177 B17 C00 MO0O YOO K65
R116 G118 B120
. o #ECB1F #ECB1F
Territorial 4747678

Cores

Paleta Secundaria

Composicao
One page Laranja-Vale Cereja-Vale Azul-escuro Azul-Vale Aqua-Vale

Boas praticas Pantone 151 C Pantone Rubine Red C C85 M70 Y00 KOO Pantone 298 C Pantone 3395 C
CO0 M55 Y90 KOO C20 M100 Y50 KOO R38 G38 B209 C70 M0OO Y00 KOO C80 MO0 Y55 KOO
R238 G111 B22 R192 G48 B94 #2626d1 R60 G181B229
ee6f16 #CO305E #3CB5ES

R10 G187 B152
#0ABB98
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Identidade Cores
Visual Barra de proporgcoes

Introducao
A barra de proporgoes € um guia para que as cores sejam aplicadas da

forma correta. Ela nos ajuda a determinar o espaco que cada cor ocupa,
garantindo a consisténcia cromatica de nossa marca.

Logo

Cores do Logo
Tipografia
Fotografia

Institucional

Cores
Composicao
One page

Boas praticas

Territorial

Cores
Composicao
One page

Boas praticas

Verde-Vale Branco Cinza Escuro Amarelo-Vale, Laranja-Vale, Cereja-Vale,
Deve estar Areas em branco Os textos em cinza Azul-escuro, Azul-Vale e Aqua-VaIe
obrigatoriamente trazem a ideia de trazem a ideia de

Trazem alegria aos nossos layouts. Escolha no maximo

presente em todos luz e garantem consisténcia. N

os materiais da leveza 35 NOSSas trés dessas cores para compor o layout
comunicagao pecas.

territorial
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Identidade Composicao

Visual
Contorno
Introducao
Logo O contorno em varias camadas tem a intencao de indicar atitudes, ideias e acdes Vocé encontra os contornos em
c o L sendo multiplicadas e reverberadas. As forcas deste elemento sao sua massa de formato de “brush” nos arquivos
Ores Ao Logo cor bem presente, a flexibilidade da sua forma e a integracao fluida que ele fornecidos junto a este guia.
Tipografia apresenta com nossas fotos. A seguir, vocé confere como utilizar o contorno.
Fotografia )
Construcao Exemplo
° ° L e [
Institucional == . ,
A forma-base do Contorno foi construida pela
Cores — — W T ey T intercalacdo de trés cores da identidade territorial @ CX[IIIE)AC;Z\O
One page p——— R R R
Boas praticas — g e—
o . Y / No Adobe lllustrator, selecione a ferramenta Brush. Em seguida,
Territorial 4

abra a aba de tipos de brushes e escolha um dos contornos.

Cores
Composicao
One page

Boas praticas

Desenhe contornando a silhueta do assunto que queira dar destaque: uma pessoa,
um objeto, uma paisagem, etc. Ao contornar a forma, utilize poucos detalhes. A
ideia nao é ser fiel ao desenho, mas sim, referencia-lo de um jeito simples.
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Identidade
Visual

Introducao
Logo

Cores do Logo
Tipografia
Fotografia

Institucional

Cores
Composicao
One page

Boas praticas

Territorial

Cores
Composicao
One page

Boas praticas

Composicao

Contorno

Os contornos devem transmitir a ideia de reverberacao do assunto da foto. Vocé encontra os contornos em
Por isso, o correto controle da espessura e proporcao desse elemento é formato de “brush” nos arquivos
fundamental para que essa mensagem seja transmitida sem ruidos. fornecidos junto a este guia.

Espessura e Proporcao

Nao utilize contornos finos. A forca do Contornos com espessura média sao os ideais.

contorno estd na sua massa de cor bem Esta espessura marca bem o layout, ao mesmo

presente. tempo que ndo disputa atencdao com imagens e
textos

Resolvendo possiveis defeitos

Durante o desenvolvimento, caso apareca algum defeito
nos contornos como no exemplo ao lado, basta diminuir
um pouco a espessura até que o defeito suma.
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Contornos grossos sao permitidos, mas deve-
se ter atencao aos outros elementos do
layout. Quando houver a presenca desta
espessura, € aconselhdvel que nao se utilize
texto. Caso seja necessaria a presenca de texto,
ele deve aparecer distante do contorno.



Identidade Composicao
Visual Contorno personalizado

Introducao

Além dos contornos em cor, existe a possibilidade de criar contornos com desenhos derivados da
cultura local. A ideia é que eles possam ser misturados aos contornos coloridos e déem mais carga
local ao assunto que esta sendo falado.

Logo
Cores do Logo
Tipografia

Fotografia )
Construcao Exemplos

Institucional #Loremlpsum

900000000000 Somam-se as formas-base dos contornos territoriais mais opcdes
Cores com o branco, pois a ideia é que 0s novos contornos criados possam

3 3E3E L33 ser colocados em cima da area em branco também.

Vivamus venenatis arcu
a molestie porttitor

Dias5e 6 Mauris suscipit

lectus justo
de dezembro vel dignissim

Composicao

One page

Boas praticas

Territorial Para criar um novo contorno, utilize o Adobe Illustrator e siga os passos

Cores abaixo. Depois disso 0 novo contorno sera adicionado a lista de brushes.

Composicao . —— ‘
ANNN NN\ window > . >

One page Brushes e

Boas praticas Construa uma New Brushiill R
unidade da
forma. Tenha em
mente que ela | fi;i‘l?ﬁ';ifil -
serd replicada ao Siga as o
decorrer do configuragoes
contorno ; |

mostradas ao lado
ou adapte-as para
0 seu brush
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Identidade
Visual

Introducao
Logo

Cores do Logo
Tipografia
Fotografia

Institucional

Cores
Composicao
One page

Boas praticas

Territorial

Cores
Composicao
One page

Boas praticas

Composicao
Caixas

Uma maneira bem simples de contar nossa histéria é através das caixas.
Elas possuem funcao de abrigar textos e sao excelentes janelas para as
nossas fotos. A seguir, vocé confere detalhes de como as caixas foram
construidas.

Construcao
As formas-base das caixas
sao geométricas e simples

. Foi aplicado o mesmo brush dos contornos nas linhas
das formas-base para atingir o resultado abaixo.

QO
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Vocé encontra as caixas ja prontas
pra uso nos arquivos fornecidos

junto a este guia.

Exemplos

Lorem ipsum
dolor sit amet

Lorem ipsum dolor
sit amet,
consectetuer
adipiscing elit, sed
diam nonummy nibh
euismod tinci.

FUNDAGAO
VALE

Lorem Ipsum
Dolor Sit Amet

Lorem ipsum dolor sit
amet, consectetur
adipiscing elit, sed do

eiusmod tempor
incididunt ut labore et
dolore magna aliqua.




Identidade
Visual

Introducao
Logo

Cores do Logo
Tipografia
Fotografia

Institucional

Cores
Composicao
One page

Boas praticas

Territorial

Cores
Composicao
One page

Boas praticas

Composicao
Caixas

As caixas podem aparecer de maneira mais integrada as fotos ao
retirarmos as formas que as compdem. Abaixo vocé confere a melhor
forma de usar este recurso.

Usos e Proporc¢ao

Lorem ipsum

dolor sit amet .
Lorem ipsum

dolor sit amet

Nao utilize contornos finos. Contornos com espessura média

A forca do contorno esta na sua sao os ideais. Esta espessura marca

massa de cor bem presente. bem o layout, ao mesmo tempo que
nao disputa atengdo com imagens e
textos.

Resolvendo possiveis defeitos

Durante o desenvolvimento, caso apareca algum defeito nos
contornos como no exemplo ao lado, basta diminuir um
pouco a espessura até que o defeito suma. Mantenha sempre
a aparéncia do baldo central préxima a sua forma-base.
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Vocé encontra as caixas ja prontas
pra uso nos arquivos fornecidos
junto a este guia.

Lorem ipsum
dolor sit amet

E possivel utilizar a parte mais
interna da caixa como janela
para fotografias. Este tipo de
aplicacdo é ideal para destacar
situagbes em uma imagem.

Lorem ipsum
dolor sit amet

A parte do meio do box
também pode ser vazada. Neste
caso, opte por imagens mais
limpas e que ndo interfiram no
entendimento do formato da
caixa.



Identidade Composicao

Visual =
llustracao
Introducao
Logo As ilustracdes enriquecem nossa identidade visual e sao indicadas para pecas mais Vocé encontra ilustragoes ja prontos
c o L livres, que tenham a intenc¢ao de agregar um valor mais artistico. A seguir, vocé pra uso nos arquivos fornecidos
Ores Ao Logo confere detalhes para a construcao de novas ilustragoes. junto a este guia.
Tipografia
Fotografia )
Construcao Exemplos
Institucional : . |
As formas-base das ilustragées sdo sempre simples e
Cores ' - com baixa complexidade de detalhes. Para que possam
Composicio ter o efeito de reverberacao, precisam ter o efeito de

Offset Path aplicado.
One page

Boas praticas

Aplique efeito de offset pelo menos trés vezes no

Territorial objeto. Para fazer isso, no Adobe Illustrator, selecione o
objeto e siga 0 caminho no menu:
Cores Object -> Path -> Offset Path -> Offset = valor de 1/3 da

largura do objeto. Selecione a forma recém-criada e

Composicao :
repita o passo mantendo o mesmo valor de offset.

One page

- @ ﬁ
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Identidade Composicao

Visual Exemplo - Rio de Janeiro
Introducao
Logo Abaixo vocé confere o exemplo de uma aplicacdo mais livre utilizando

referéncias territoriais.
Cores do Logo

Tipografia
Fotografia

Padrdes personalizados

Inst|tuc|ona| _.\* ' aeigel . @ - : para. cada territério.
- Inspirados na cultura local.

Cores

Composicao

One page

Boas praticas

£

|

i. ;

l— FUNDACAO
‘ VALE

b

Territorial

Cores

Composicao

One page Cores baseadas no assunto

territorial e adaptadas a
paleta da Vale.

Boas praticas

Paisagem do Rio
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Identidade Composicao

Visual Exemplo - Maranhao
Introducao
Logo Abaixo vocé confere o exemplo de uma aplicacdo mais livre utilizando
referéncias territoriais.
Cores do Logo
Tipografia
Fotografia
Padrées personalizados
Institucional para cada territorio.
Inspirados na cultura local.
Cores i

Composicao

One page

g FUNDACAO
VALE -

Boas praticas

Territorial Babacu
Cores
Composicao
One page Cores baseadas no assunto
Boas praticas territorial e adaptadas a
paleta da Vale.
Fitas
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Identidade One page

Visual Resumo da identidade territorial
Introducao
Logo O painel abaixo mostra o resumo da identidade com os Todos as versdes dos logos da Fundagao Vale estao disponiveis no Pacote
principais elementos do universo visual da Fundacao Vale. de Identidade Visual que acompanha este guia. La vocé também
Cores do Logo encontra os grafismos em modo editavel e layouts editdveis para
Tipografia Respeite proporc¢ao de cores na régua deste resumo. consulta.
Fotografia
Institucional A vale Sans Light \V/alle ians TRhm |
. ale Sans Regular
Cores I\:/X[lgAng Vale Sans Medium Vale Sans Semibold
Vale Sans Bold Vale Sans Extra Bold

Composicao

One page

Boas praticas _

Territorial

Cores

Composicao

Suspendisse lorem
turpis venenatis sed

p g Sed porttiter justo sed congue fermentum,
In et efficitur quam. Curabitur posuere
facillsls erat, vel porta dul elaifend cursus.
Hulla convallis rutrum arcu. Aenean nec lea

Boas praticas il o i s e

; il
@ FUNDAGAO : o o BN s
< " It ’ o
VALE . : R . Phasellus  [Tmmrns
. 1 (| it 15,02 A o by
Vol Wizt e ol el e

lllllllllllllllllllllllllllllllllllll

Sed vulputate
diam auctor

Cras sed nisi sed
libero euismod
auctor diam.
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Identidade Boas praticas
Visual

Introducao
Logo

Cores do Logo
Tipografia
Fotografia

Institucional

Cores

S mipsum

Sed diam nonummy nibhna
euismod tincidunt ut laoreet

Composicao
One page

Boas praticas

_ Dias5e 6  Nostrud exerciTation
Territorial 4  dedezembro  onummy Nin
Cores .-

Composicao

Pas ‘ . s it e S FUNDAGCAO
o | __ - S s 0 P VALE 5
Boas praticas : e 5 2gs e o W .
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Identidade

Visual
Introducao
Logo
Cores do Logo
Tipografia
Fotografia
Suspendisse lorem
° : w®
Institucional turpis venenatis sed
Cores Sed porttitor justo sed congue fermentum.
— In et efficitur quam. Curabitur posuere
Com pOsSIGao facilisis erat, vel porta dui eleifend cursus.
0 Nulla convallis rutrum arcu. Aenean nec leo
ne page vel odio bibendum imperdiet congue ac

Boas pr aticas nulla. Orci varius natoque penatibus.

G000000000000000000000000000000000000

Territorial Phasgis G
15/02 wosreee =
Cores uuuunuuuzuouu-uu_unuooio
Composicao
One page

Boas praticas
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Identidade Boas praticas
Visual

Introducao
Logo

Cores do Logo
Tipografia
Fotografia

Institucional

Cores

Composicao

FUNDACAO

FUNDACAO UNI
v

One page
VALE

Boas praticas

Territorial
Cores
Composicao
One page

Boas praticas
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Para que a nossa marca seja bem
construida, todos precisam seguir
as recomendacoes deste manual.

Se vocé quiser saber mais, se nao
encontrou aqui a informacao

que buscava ou se tiver
sugestoes, entre em contato com
o ponto focal de comunicacao da
Fundacao Vale.
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